ApPPENDIX C.  Managing Files and Folders

Define the Problem = Organizing, storing, and retrieving information.

Solution Strategy = Use an organizational strategy analogous to historic office paper file
folders and filing cabinets. Create and name files, copy and move
them, change names, delete items and recover deleted items, and
backup in case of accidental loss or failures.

The storage capacity of newer hardware devices is so great users need easier and more
powerful ways to identify, find, and access information. Like any office filing system, the
computer operating system must organize and inventory all stored information. Most
operating systems organize information in a hierarchical structure referred to as a directory,
catalog, or folder. It is critical that you understand the information management concept and
be able to adjust and organize it to meet your specific needs.

Early personal computer DOS operating systems used the nomenclature “catalog” to
look for where files had been stored on a diskette and had very restrictive rules for naming
files. MS-DOS and early versions of Windows used the terminology “directory” and
“directory tree” to organize where files were stored. The common terminology used in
business offices has now been adopted by Windows 95/8/2000/Me/ XP/Vista and
Windows NT into the computer operating system environment. The familiar concept of
documents stored in file folders is now used. To move something from one place to another
is done by “cut” and “paste,” while duplicating something from one place to another is done
by “copy” and “paste.” Windows allows you to graphically add and delete folders or cut,
copy, paste, and delete files within a folder. Descriptive file names can be used. File types
can be identified by name extensions or graphical icons. Folders and files can be easily
opened to view their contents, and deleted files are saved in a recycle bin from which they
can be recovered until the “trash” is emptied.

Windows provides two different programs that allow you to create and navigate through
the organizational structure used to store and retrieve information. “My Computer” and
“Windows Explorer” both do similar things, but in slightly different ways.

Viewing Folders and Files

A folder 1s a separate area on your system’s storage device that is set up to organize and
store other folders, files, and programs. It is analogous to a file folder in a filing cabinet; it
is a place to put items. Folders can be put inside folders and organized into a hierarchical
“tree” structure. When Windows was installed on your computer, several folders were
automatically created on the internal hard disk drive that keeps the operating system files
organized and separate from other files. A “path” is created through a series of folders and
sub-folders, represented by open and closed file folder icons, to individual files or
documents.
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C.1 UsiNng My Computer WRRSEINEREES . 2000 & XP - E

My Computer is a graphical program that allows you to create a file-folder structure,
view, and organize your system. To start My Computer, double-click the My Computer
icon on the desktop. A My Computer window will appear similar to the one’s illustrated in
Figure C.1.a. for Windows 2000 and Figure C.1.b. for Windows XP.
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Figure C.l.a. The Windows 2000 My Computer Window.

The way in which the contents are displayed can be changed to suit your needs and
preferences. Select View from the menu bar to display the options available:

e whether various Toolbars » and the Status Bar are displayed can be toggle
switched Y on or off;

* one of four contents displays of * Large |cons (illustrated above), Small Icons,
List, or Detailscan be selected;

* the sequence in which the contents are displayed can be selected with Arrange Icons
» byDrivelLetter, Type, Size, Free Space, or Auto Arrange;

* whether the icons are manually moved around the window or automatically Line
up Iconsis an option;

* as well as Refresh which updates the display to show current status after changes.
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Figure C.1.b. The Windows XP My Computer Window.

—> TryThis! #C-1 My Computer = Determine the resources connected to your

computer.

Define the Objective = Explore the various ways to view contents of a storage device.

[J Open My Computer.

Prepare a Word Pad document listing the answers to the

2.

[0 Click View and then toggle ¥ the “Standard Buttons” and “Address Bar”

Toolbars on.

What are the devices {disk drives and other physical resources} connected to your

computer ?
[

the hard disk drive C.

Double-click the drive C: icon to open a window showing the contents of

0 Double-click the WINNT folder in Windows 2000 or the WINDOWS

folder in Windows XP.

Find the a folder in the My Documents structure and display the contents.
Click View and experiment with the different tool-status bar and viewing

options. The last options you use will become the default options the next

time you start My Computer from your profile.
[0 Click Toolsand then click Folder Options... .
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Figure C.2. The Windows XP Tools Menu and Folder Options.

?
U

¥ Under the “General tab,” what are the four selection topics ?

In the “Browse folders” box select your personal preference
[J  Open each folder in the same window
[J  Open each folder in its own window

Under the “View tab,” what are the two selection topics ?
[J  Inthe “Advanced settings:” window,

0  Check Display full path in address bar

U  Uncheck D Hide file extensions for known types
[J  Click OK to accept these changes and return to the WINNT folder
contents and evaluate what happened
Return to the Tools/ Folder Options... / select your personal preferences

If you are in the “own window” mode, close all windows except the
original “My Computer” window displaying the drive devices attached;

If you are in the “same window” which changes with each successive
window selected, activate the Toolbar menu and use the “Up One Level”
folderd button to back up, or use the “View”/“Go to » ” to go to the “My
Computer” window displaying the drive devices attached.

Return to the desktop.
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C.1.1 Mapping Links to Drives and Folders oncomputerswired into a network

The “My Network Places” icon allows you to access resources throughout the entire
network similar to the way My Computer navigates device resources directly connected to
your individual computer. It is possible to map links to other network resources and connect
them to your computer so that they appear in the My Computer window. These connections
can be automatically restored at logon if desired. Mapping is done from the My Computer
window by selecting “Map Network Drive...” under the Tools menu, which activates a
dialog window similar to the one diagramed in Figure C.3

Map Network Drive E

Windows can help you connect to a shared network
folder and assign a drive letter to the connection so that

‘\ﬂ you can access the folder using My Computer.
——

e | Specify the drive letter for the connection and the folder
that you want to connect to:

Drive: | Z: v

Folder: b Browse...

Example: \\server\share
[|Reconnect at logon

Connect using a different user name.

Sign up for online storage or connect to a
network server.

Cancel

Figure C.3. Diagram of Map Network Drive window.

Mapped resources are assigned device letters similar to the way the floppy diskette
drive is designated A: and the hard drive is designated C:. When mapping a drive the
default letter assigned is the next available letter unless a specific letter is designated from the
drop-box list of available letters.

C.1.2 Creating Shortcuts

Shortcut icons make it easier to access the resources (drives, folders, programs, etc.)
that you use most frequently. Shortcuts can appear as icons on the desktop or as items added
to a menu folder. Double-clicking a desktop shortcut icon opens the resource window or
executes the program.

To create a desktop shortcut, first open the window containing the item you want.
Then there are two methods to create the shortcut :
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* Right-click on the item to display a pop-up menu; select “Create Shortcut” and follow
the dialog box instructions.

* or, right-click the item’s icon and hold down the right mouse button as you drag the
icon to the desktop. Release the mouse button when the icon is over a blank area of the
desktop to display the Shortcut pop-up menu. Select “Create Shortcut(s) Here” to
create the shortcut.

C.1.3 Creating New Folders

Folders are areas created on disks to store and organize files, programs, or other folders
to further organize groups of files. Two methods to create a new folder once My Computer
has been opened and a particular drive device has been selected are:

* Right-click on a blank space inside a drive or folder window to display a pop-up menu;

* or, left-click on File from the menu bar to display a similar menu as illustrated in
Figure C.4.

Then click New, followed by selecting Folder; a “New Folder” icon appears in the window
with the folder name highlighted and boxed. To give the folder a different name from the
default, type in the desired name and press Enterl] to save the folder with the new name.
You cannot use duplicate folder names within the same folder or root directory of a device.
If this is not the first new folder you have created in the same area using the default folder
name, the new folder name will appear as “New Folder (X)” where X is the number of the
new folder created.
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Figure C.4. Creating a New Folder.

—> TryThis! #C-2 CreateFolders = Start My Computer.
Define the Objective = Create folders to store materials for different classes.

[J Double-click the C: drive icon and navigate your way to your personal
space, or double-click the drive letter assigned to it (referred to as Personal:
in the rest of this discussion) if you mapped a link in Try This! C-2 to open
a window showing the contents of your personal storage space on your
CHE Department account.

[0 Create 3 new folders named “Chemistry”, “Math”, and “ChE 123”.
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[ Arrange the icons by selecting “View” on the menu bar and pointing to
“Arrange Icons” to display a second menu.

[0 Click “by Name” to sort the icons alphabetically by name; repeat clicking
“by Date” to sequence them by the date they were created or last modified.

[J Return to the desktop.

Folders can be created on drive devices (any of the icons shown in the “My Computer”
window), or as sub-folders inside other folders, or they can be created directly on the desktop
(in which case they are actually placed as subfolders inside the C:\ WINNT \ Desktop\ ...
directory).

On a network system, the network administrator has control to set access permissions
on each device or deny access. A user can be authorized to access a device with full read
and write capability; or access can be restricted to “Read Only” (the ChE123 class folder is
set in this mode so that students cannot accidentally change or write over master data files,
only the instructor can write to and modify information in his folder) or “Write Only” (the
“Turn In Projects” folder is an example of this, where students can submit assignments by
writing to this folder but they can not read or see anything in the folder, only the instructor
and TA can read what is there).

C.14 Copying and Moving Files

Files or entire folders can be copied or moved using My Computer by either pointing
to and dragging the file or folder icon from one location to another, or by using the Cut (or
Copy) and Paste commands.

To copy or move a file or entire folder in My Computer using the Cut (or Copy) and
Paste commands method, highlight the icon (or select multiple icons by simultaneously
holding the “Ctrl” key and clicking on the desired items) of the file or folder. Then click
Edit on the menu bar and then click either Cut on the pull-down menu to move the item(s) or
Copy to duplicate them. The files or folders selected will be cut and moved, or copied to the
“Clipboard.” To paste the previously cut or copied items to a new location, open the
window for the location where you want to place the items as the active window. Click Edit
on the menu bar, and then Paste from the pull-down menu. The items residing on the
Clipboard are now placed in the new location.

To use the point-and-drag method, first open a window on the location where the items
currently reside and then a second window for the new location they are to be placed. Make
sure both windows are visible on the screen. Next click on the icon(s) of the files or folders
you want to copy or move (Ctrl-click to select multiple items). Then hold the right mouse
button down and move the shadow image of the items to the correct destination drive, or
folder window, or icon. When the shadow image is in or over the destination window or
icon, release the mouse button to display a pop-up menu. To move the items click M ove
Here; to copy the items click Copy Here. The option displayed in bold is the previous
point-and-drag action you did and the current default action for subsequent point-and-drag
operations. It is possible to conduct move or copy operations after selecting the items by
holding the left mouse button down (instead of the right) and dragging the shadow image to
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the destination and releasing the mouse button; no pop-up menus appear and the item is
directly moved or copied, whichever is the previous default action.

C.15 Renaming Files or Folders

Items can be renamed using My Computer by selecting (clicking on to highlight) the
file or folder, then clicking File on the menu bar, and then Rename. Alternately, a right-click
on the item will generate a pop-up menu from which Rename can also be selected. Yet
another technique is to single left-click the item name and then pause a few seconds (longer
than the double-click timer) and then single left-click again, this will directly enter the
selected name into the rename edit mode. The name of the item will be highlighted inside a
box outline and you can type in a new name or edit the current name; pressing Enterl] or
left-clicking another item implements the change.

A file or folder name can contain up to 255 characters, including spaces. It cannot
contain the following 9 characters: \ / : * ? " < > |

C.1.6 Dédeting Files or Folders

My Computer offers at least four ways to delete a file or a folder and all its contents.
1) You can point to (clicking on to highlight, or Ctrl-click to do multiple items) the icon(s),
then click File on the menu bar, and then Delete. 2) You can point to the item in the
window, left-click it, and then press the Delete key. 3) You can point to the icon, right-click
to obtain a pop-up menu and then left-click Delete. 4) You can also point to the icon and
hold the left mouse button down and drag the shadow image of the icon to the Recycle Bin
trash can and release the button (same as point-and-drag moving items except the destination
is now the trash can!). All methods display the same Confirm File-or-Folder Delete dialog
box. Click the Yes button to delete the items listed, or click the No button to cancel the
delete command.

C.1.7 Recovering Deleted Files or Folders

Deleted items from the internal hard drive have not really been completely deleted in
Windows. They have actually been moved to the Recycle Bin on the desktop. From the
desktop, double-click on the Recycle Bin icon to display a window showing the contents of
the trash can. Items can be recovered by selecting (clicking on to highlight) the file(s) or
folder(s), then clicking File on the menu bar, and then Restore as illustrated in Figure C.5.a;
the items will be un-deleted and restored to their original locations from which they were
deleted. Alternatively, the selected items can be Deleted a second time to completely
remove them and free the storage space for new items, or Empty Recycle Bin can be used to
delete all the items in the trash can as illustrated in Figure C.5.b.
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® Recycle Bin ® Recycle Bin
G Edr Vew Favort:
Restone Empty Recyde Bin
Dt
Properties
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Figure C.5. a.) Restore from Recycle Bin b.) Empty Recycle Bin.

Deleted items from removable storage devices like floppy diskettes, Zip disks, USB
flash memory sticks, etc., are not moved to the recycle bin, and hence, are not recoverable
and are completely deleted the first time. [ ChE Dept. LAN Note - due to the multiple
user, broad public access to the 10 machines in the BEL 345 lab, deleted items ARE NOT
moved to the Recycle Bin, delete once and they are gone forever. This way the system
administrator does not have to go through each machine and the server daily emptying the
Recycle Bin and clearing hard drive space so the machines will function the next day. ]

—> TryThis! #C-3 Recover Deleted Items = Start My Computer and open a

window to the C: \ Temp folder.

Define the Objective = Recovery of files which have been deleted.

[ Note - this exercise cannot be done on the ChE Dept. BEL 345 lab computers (see
previous note on deactivated Recycle Bin). It should be a useful tutorial on most
stand alone computers. |

[
[

Create a new folder named “123student” and open that folder.

Start a second My Computer window and open your personal storage space
or the drive letter assigned to it (referred to as Personal: in the rest of this
discussion).

Copy the 3 folders named “Chemistry,” “ChE 123,” and “Math”
(created in the previous Try This! C-2) from your Personal: drive to the new
C:\Temp \ 123student folder.

Arrange the C: \Temp \ 123student folder icons by selecting “View” on the
menu bar and pointing to “Arrange Icons” and the sort “by Name”.

Save and then copy your Word Pad Memo document file to the new drive
C:\Temp\ 123student “ChE 123” sub-folder. Make a back-up copy of the
memo file in both the new drive C: \ Temp \ 123student “Chemistry” and
“Math” sub-folders.

Rename the C: \Temp \ 123student “Chemistry” folder to “More Stuff” and
rearrange the icons by name again.

Move the C: \Temp \ 123student folder “More Stuff” to your Personal: drive
space.

Delete the “Math” folder from the C: \ Temp \ 123student folder.
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—> TryThis! #C-4 Recover Deleted Items = { continued }

Minimize the C: \Temp \ 123student window.
Return to the desktop.
Open the Recycle Bin and restore the “Math” folder.

Close the Recycle Bin and restore the C: \ Temp \ 123student window from
the task bar.

? |sthe“Math” folder recovered ?
? |sthe“Memo’ filerecovered ?

N I I B A

BINGO!! = Congratulations, you are now capable of fundamental organizing,
getting around, and managing your files and folders using the Windows
operating systems.

[ Delete the “C:\Temp \ 123student” folder.
[ Close all applications and return to the desktop.

C.1.8 Backing Up Files and Auto-Save Options

Failures and accidents happen all too frequently when using PC systems. Storage
media can become defective and any information stored on it will be lost. Computer viruses
can invade systems and corrupt programs, documents, and files. Electrical power failures
happen occasionally (particularly during thunder and lightning storms causing brief voltage
surges and micro-second outages which cause computers to turn off and re-boot) and all work
done since the last time files were saved to permanent media are instantaneously lost forever.
Hence, to minimize the amount of work that must be re-worked to regenerate damaged or lost
files, ITISA GOOD HABIT TO DEVELOP to frequently make BACK-UP
COPIES on different storage devices or media.

Many Windows applications programs have automatic back-up save features that can be
activated from Tools on the menu bar:

»  For example in Word 2000 select Tools, Options..., the Save tab, Save Auto
Recover info every: “X’ minutes.

»  For example in Excel 2000 select Tools, Add-Ins..., check the ¥ Autosave Add-in;
this places the AutoSave ... feature in the Tools menu where it can be set to
Automatic Save Every “X” Minutes.

If the application, or Windows, is abnormally terminated without closing all files, when the
application is re-opened it attempts to recover these files. The “auto-saves” operate in the
background and usually do not noticeably slow down the operation of the program. Another
GOOD HABIT TO DEVEL OP is to periodically click the Save button on the
Toolbar (or press Ctrl+S) to manually save an updated version of the open file. Thus only
work done since the last save is lost forever and must be redone unless a power outage or
failure occurs during the actual save operation, in which case everything is lost.

Since many times you will be moving your school work between numerous computers
and independent systems (the ChE BEL 345 lab, the JEB 321 classroom, various Ul public
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labs, personal residence systems, etc.), you should MAKE MULTIPLE BACKUP
COPIES ofyourworkon DIFFERENT TYPES OF PORTABLE MEDIA. On
many assignments in ChE 123 you will be working in teams and sharing work with
classmates; each student is responsible for having a copy of the group’s work (the excuse
that a team member that doesn’t show up one day has your work, is not acceptable for late or
missing assignments). USB Flash M emory sticks are the most practical and common
media currently used. Floppy diskettes (3.5”) and Zip disks are outdated media with drives
no longer available on many computers. CD-R (one time recordable) disks are reliable,
inexpensive, and can be read on most machines with standard CD drives, but CD-RW drives
that will write them are rare on public lab computers; CD-RW (re-write) disks can not be
read on most standard CD drives, only CD-RW drives, which are not available on student lab
computers, will read these disks. E-mailing files to yourself and team members as
attachments is practical.

33

Cc.2 UsINcg Windows Explorer Windows 2000 EXPLORER

Windows Explorer performs the same basic operations on drives, folders, and files as
My Computer does. The Exploring window consists of two separate panels, or sections, as
shown in Figure C.7. Windows XP accesses the Explorer style window from opening
My Computer selecting “View” then “Explorer Bar [»]” and checking [/] Folders as
illustrated in Figure C.6; or by selecting the “Folders” icon on the top menu bar.
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Figure C.6 Accessing Explorer in Windows XP.

The “Folders” panel on the left shows the contents of the current drive in a hierarchical
“directory tree” view. The panel on the right shows the contents of the item selected from
the Folders panel. The Folders panel allows you to see the organizational structure of all the

storage devices connected to your computer. A [+ mark in the box next to a device or
folder in the Folders panel indicates that sub-folders reside within that device. Clicking on

the [+ mark expands the tree to show the next level of sub-folders in the right Folders panel
and toggles to a |{ mark in the box. Clicking on the H mark collapses the tree back to the

form. Clicking on a device or folder name to select it will display the contents of that
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folder in the right “contents” panel. Figure C.7.a shows the fundamental desktop structure of
a Windows 2000 system with the My Computer selected and the device structure displayed in
the contents panel. Figure C.7.b shows the fundamental desktop structure of a Windows XP
system. Figure C.8 shows the My Computer tree expanded and the Control Panel folder
selected to display its contents.
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Figure C.7.a Sample Windows 2000 Explorer.
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Figure C.7.b Sample Windows XP Explorer.
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Figure C.8 Sample Windows 2000 Explorer with expanded directory tree.

If you double-click on a folder in the right contents panel, Explorer will expand the left
Folders tree to make the selected folder the highlighted item and it will display the contents
of the selected item in the right contents panel. If an item selected with the double-click in
the contents panel is an executable program, such as Excel, the program will execute and
start running. If an item selected is a document file from an application, such as an Excel
workbook .xIs file, the application will run and open the selected file so it can be viewed.

With Explorer you can create new folders in the selected right contents panel using the
File/New » Folder menu sequence. Folders and files can be copied or moved by selecting
them in the right contents panel and holding the left button while dragging them to a new
location folder in the left Folders panel. The Cut, Copy, and Paste menu or tool bar buttons
can also be used to accomplish these actions within Windows Explorer.
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c3 SUMMARY

The fundamental tasks you should be capable of manipulating with the Windows
operating system include navigating through the Network, mapping links to drives, creating
and naming files and folders, then copying, moving, renaming, and deleting them. Either My
Computer or Windows Explorer can be used to accomplish these operations. It is also
handy to be able to recover deleted items from the Recycle Bin (on machines where this is
operational) and to make back up copies of your work on different storage devices.

Minimum skills you should be fluent in doing before proceeding with the ChE. 123
course include:

v' Navigating = section C.1 Try This! # C-1.
v' Creating Short Cuts = section C.1.2

v Creating Folders = section C.1.3 Try This! # C-2.
v Copy, Move, Rename, = section C.1.4-7 Try This! # C-3.

Delete, Recover

v' Backing Up

section C.1.8.

Minimize the amount of work that must be re-worked to regenerate damaged or lost
files, ITISA GOOD HABIT TO DEVELOP to frequently make

BACK-UP COPIES on different storage devices or media.

A file or folder name can contain up to 255 characters, including spaces. It cannot
contain the following 9 characters: \ [/ : * 2?2 " < > |

Also beware that:

# 1 these give the web FTP (File Transfer Protocol ) interface problems

D.C.Drown - - August 2007 printed August 20, 2007
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